APPENDIX VI – 3
PBIS 1
Why PBIS?

To make schools:

- PREDICTABLE
- CONSISTENT
- POSITIVE
- SAFE

PREDICTABLE-CONSISTENT-POSITIVE-SAFE

How do we achieve this kind of school culture?

How do we achieve this kind of school culture? (predictable, consistent, positive and safe)
What needs to happen? What would your school look like?
Choose one person to report back to the group.

Characteristics of PBIS
George Sugai and Brandi Simonsen. Center for PBIS and Center for Positive Behavioral Interventions and Supports, University of Connecticut

- 1. The PBIS framework is based on student outcomes
- 2. Adoption of evidence and research-based practices
- 3. Consistent with the response-to-intervention
- 4. The effective, efficient, and relevant use of data or information to guide decision-making
Goal 1: Behavioral Expectations are **Defined**.
- A small number of behaviors
- Clearly defined in positive, simple expectations or procedures. (some would rather say rules)
- Be Respectful: Respect Yourself
- Be Responsible: Respect Others
- Be Safe: Respect Property

Goal 2: Behavior Expectations are **Taught**.
- Behavioral expectations are taught in real settings
- Describe what each rule means and looks like in each of the settings.

Goal 3: Appropriate Behaviors are **Acknowledged**.
- Once appropriate behaviors have been defined and taught, they need to be acknowledged on a regular basis.
- Acknowledgement may be done through a formal system like tickets, coupons.
- Acknowledgements may be done through social events where students are recognized.

https://www.youtube.com/watch?v=rSdrMbpwyLU
Goal 4: Behavioral Errors are **Corrected Proactively**.

- Clear procedures are needed to provide information to students that their behavior was unacceptable.
- Clear procedures are needed to prevent the unacceptable behavior to receive inadvertent rewards or attention.

**PBIS teaches appropriate behavior to all students by developing procedures to accomplish 4 goals.**

- reduce office referral rates
- improve attendance and school engagement
- improve academic achievement
- reduce dropout rates
- improve school climate

**Why Do Schools Need PBIS?**

- Well, the USP says we need it! !!
- Seriously, the goal is to:
  - reduce office referral rates
  - improve attendance and school engagement
  - improve academic achievement
  - reduce dropout rates
  - improve school climate

This list is your job description, but buy in by the staff is a must. You are not the PBIS person. You are the leader, but everyone or at least 80% of the staff need to participate.

I want you to think about your school and go to each poster and write what you already have in place that shows:
1. student outcomes
2. evidence and research based practices
3. consistent response to intervention
4. use of data to make informed decisions

[https://www.youtube.com/watch?v=MZ1kDWv-uv0](https://www.youtube.com/watch?v=MZ1kDWv-uv0)
Using your white board write where you feel most misbehavior occurs during the day.

4 Components of PBIS

- **PBIS**
  - Positive Behavior Intervention and Support
  - Tenets: Behavioral Instruction and Intervention
    - Proactive, Preventative, Efficient

- Establish Expectations
  - All Areas: All Staff and Students

- Explicitly Teach Expectations
  - All Areas: All Staff and Students

- Reinforce Expectations
  - All Areas: All Staff and Students

- Correct Behavioral Errors
  - All Areas: All Staff and Students

EVIDENCE-BASED INTERVENTION PRACTICES

**SCHOOL WIDE**

1. Leadership team
2. Behavior purpose statement
3. Set of positive expectations & behaviors
4. Procedures for teaching classroom-wide expected behavior
5. Continuum of procedures for encouraging expected behavior
6. Continuum of procedures for discouraging rule violations
7. Procedures for on-going data-based monitoring & evaluation
**Evidence-Based Intervention Practices**

**CLASSROOM**
1. All school-wide
2. Maximum structure & predictability in routines & environments
3. Positively stated expectations posted, taught, reviewed, prompted, and supervised.
4. Opportunities to respond and do well academically
5. Continuum of strategies to acknowledge displays of appropriate behavior.
6. Continuum of strategies for responding to inappropriate behavior.

**INDIVIDUAL STUDENT**

1. Behavioral competence at school & district levels
2. Function-based behavior support planning
3. Team & data-based decision making
4. Comprehensive person-centered planning & wraparound processes
5. Targeted social skills & self-management instruction
6. Individualized instructional & curricular accommodations

**NONCLASSROOM**

1. Positive expectations & routines taught & encouraged
2. Active supervision by all staff (Scan, move, interact)
3. Precorrections & reminders
4. Positive reinforcement

**FAMILY ENGAGEMENT**

1. Continuum of positive behavior support for all families
2. Frequent, regular positive contacts, communications, & acknowledgements
3. Formal & active participation & involvement as equal partner
4. Access to system of integrated school & Community resources
https://www.youtube.com/watch?v=nP1wcvekwxU

CREATE A MATRIX

KEEP IN MIND

You will want your expectations to be:

- No more than 5
- Keep it simple
- Positively stated
- Be specific
- Observable, Measurable
- Publicly Post in a prominent place (in other words everywhere)

TIPS FOR A GOOD MATRIX

- SOMETHING THAT IS EASY TO CATCH ON TO
- SOMETHING THAT IS SCHOOL SPIRIT
- KEEP IT RATHER SHORT (4 OR 5) WORDS
- SCHOOL LOGO
- NAME OF SCHOOL (IF IT IS SHORT)
- SOMETHING THAT ALL AGES UNDERSTAND
ACKNOWLEDGING POSITIVE BEHAVIOR

Go to the white paper on the wall and write down rewards for positive behavior

Be creative
Be sensitive to what students would enjoy
Be fun

THANK YOU SO MUCH FOR A LOVELY CLASS
PBIS 2
POSITIVE BEHAVIORAL INTERVENTION SUPPORTS #2

REVIEW
- Where is the matrix?
- Is there common language?
- Is there a system wide focus on positive behavior?
- What did you put in place for new students?
- Have you held a "kick off" assembly?

TESTING????

MAKING IT HAPPEN
- Planning another staff development
- Teaching behavior expectations
- Develop plan for recognizing appropriate behaviors
- Design consequences system for reducing inappropriate behavior
- Individual support systems are integrated school wide
BEHAVIOR IS LEARNED AND CAN BE TAUGHT

FOUR ESSENTIAL ELEMENTS
- **CLARITY**: plan, expectations and procedures clear to all
- **CONSISTENCY**: school and family using the same plan, expectations and rewards
- **SIMPLICITY**: simple, practical, accessible
- **CONTINUATION**: even as behavior improves it is important to keep the teaching and the positive supports in place

COMPARISON OF TRADITIONAL BEHAVIOR MANAGEMENT AND POSITIVE BEHAVIORAL SUPPORT

<table>
<thead>
<tr>
<th>Traditional Behavior Management</th>
<th>Positive Behavioral Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views individual as &quot;the problem&quot;</td>
<td>Views systems, settings, and skill deficiencies as &quot;the problem&quot;</td>
</tr>
<tr>
<td>Attempts to &quot;fix&quot; individual</td>
<td>Attempts to &quot;fix&quot; systems, settings, and skills</td>
</tr>
<tr>
<td>Extinguishes behavior</td>
<td>Creates new contacts, experiences, relationships, and skills</td>
</tr>
<tr>
<td>Takes days or weeks to &quot;fix&quot; a single behavior</td>
<td>Takes years to create responsive systems, personalized settings, and appropriate/empowering skills</td>
</tr>
<tr>
<td>Implemented by a behavioral specialist</td>
<td>Implemented by a team</td>
</tr>
<tr>
<td>Often resorted to when systems are inflexible</td>
<td>Flourishes when systems are flexible</td>
</tr>
</tbody>
</table>

https://www.youtube.com/watch?v=59Hjbtn6gmE
COMMON LANGUAGE

THINK OF ONE THING YOU SAY ALL THE TIME THAT IS A DIRECTIVE AND FIGURE OUT HOW TO MAKE IT AN ENFORCEABLE STATEMENT.

https://www.youtube.com/watch?v=5C-WyyhJPNk

MOST STUDENTS RESPOND WELL TO CHOICES
**CHOICES**

A. You're welcome to _______ or ________.

B. Feel free to _______ or ________.

C. Would you rather _______ or ________?

D. What would be best for you _______ or ________?

**PERSISTENT PROBLEMS**

TRY SAYING: I'M GOING TO HAVE TO DO SOMETHING. I'M NOT SURE WHAT JUST YET. TRY NOT TO WORRY TOO MUCH ABOUT IT. I'LL LET YOU KNOW WHEN I DECIDE HOW I'M GOING TO RESPOND.

**Systems for Reducing Inappropriate Behavior**

- Level of Behavior
- Level of Consequences

**THINK TIME STRATEGY**

Think Time includes three elements:

1. A precision request that reduces or eliminates warnings and/or repeated requests through early intervention by the teacher.
2. A time-out procedure, contingent on observation, or contingent on withdrawal of attention when a disruptive behavior has occurred.
3. A debriefing process to provide students with feedback regarding their behavior and to plan for the future.
Think Time strategy encourages:

- Teachers to expect more from their students
- Students to take more responsibility for their behavior
- Teachers to realize that repeated warnings actually promote disruptive behavior
- Teachers to realize that there really can be one response for all types of behavior
- Teachers to catch disruptive behavior early to keep it from escalating

Think time is designed to:

- Cut short a negative social exchange
- Provide the student with feedback and plans for subsequent performance
- Start a positive social exchange

Think time is not the time to embarrass the student by sending them to a much younger classroom. Think Time is not a punishment.

PLANNING WITH YOUR TEAM

- Periodic PBIS Team meetings
- Staff Feedback
- Promotion and program evaluation-ongoing
THANKS SO MUCH FOR COMING TO LEARN ABOUT PBIS - KAREN WARD
## Hudlow PBIS Playground

<table>
<thead>
<tr>
<th>Be Respectful</th>
<th>Playground Contract for ____________________________</th>
<th>Signatures</th>
</tr>
</thead>
<tbody>
<tr>
<td>o I will keep my hands, feet and objects to self</td>
<td></td>
<td>I will be respectful</td>
</tr>
<tr>
<td>o I will use appropriate language</td>
<td></td>
<td>_______</td>
</tr>
<tr>
<td>o I will share and take turns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will show sportsmanship</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will respect the environment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will include others</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will use kind words</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Be Responsible</th>
<th></th>
<th>I will be responsible</th>
</tr>
</thead>
<tbody>
<tr>
<td>o I will use equipment as intended</td>
<td></td>
<td>_______</td>
</tr>
<tr>
<td>o I will follow game rules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will line up when bell rings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will secure equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will <strong>Enter</strong> and <strong>Exit</strong> the school with hallway procedures</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will wear shoes for playing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Be Safe</th>
<th></th>
<th>I will be safe</th>
</tr>
</thead>
<tbody>
<tr>
<td>o I will stay in supervised areas</td>
<td></td>
<td>_______</td>
</tr>
<tr>
<td>o I will ask an adult if I need help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will play games that abide by the hands-to-self rule</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will ask for permission to leave the area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o I will only run in grassy area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>o If I hurt someone, I will take them to the nurse</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

I understand that if I am unable to keep this contract, I will need to make a plan.
PBIS 3
Glossary of PBIS Abbreviations and Terms

AA

Administrator Academy: provides professional development opportunities for school administrators.

Action Plan

School-Based Unified Action Plan, Multi-Tiered Action Plan (MAP) or a tool that serves a similar function: combines data from multiple sources (e.g. SAS, TIC, BoQ, Pol, etc.) and helps teams prioritize and detail step-by-step activities and timelines to guide implementation steps and technical assistance.

AYP: Adequate Yearly Progress

NCLB Act requires states to measure Adequate Yearly Progress (AYP) of all schools/districts to determine if they are successfully educating their students. Each school must comply with proficiency requirements in all categories of students until 100% proficiency rate is reached.

BAT

Benchmark for Advanced Tiers: A self-assessment tool used by school teams to self-assess the implementation of behavior support systems at Tiers 2 & 3

BEP

Behavior Education Program (Crone, Horner, & Hawken): A targeted (or Tier 2) intervention otherwise known as Check-In/Check Out (CICO).

BIP
Behavior Intervention Plan: An intervention strategy used when behavior impedes learning – a written intervention plan is developed based on the results of an FBA to provide highly individualized behavior support for a student across all settings in school.

BSP

Behavior Support Plan: Another name for a Behavior Intervention Plan.

“Big 5” data

Data graphs critical to school-wide decision making, created by entering data into SWIS (School Wide Information System) which are aggregated by:

1. Average Referrals Per Day, Per Month
2. Referrals by Problem Behavior
3. Referrals by Location
4. Referrals by Student
5. Referrals by Time

BoQ

Benchmarks of Quality: A self-assessment tool that provides coaches and school-based teams with a way to identify and evaluate areas of strength, and areas in need of improvement, for the purpose of action planning.

BP

Bullying Prevention: Within PBIS, “giving students the tools to reduce bullying behavior through the blending of school-wide positive behavior support, explicit instruction, and a redefinition of the bullying construct.” (Ross, Horner, Stiller)

Check-and-Connect

(Sinclair, et al) - Comprehensive strategy used to provide support to those students in need of targeted or more individualized interventions/support. (Typically treated as a Tier 2 support.) Mentoring and individual student planning are critical features of Check and Connect.

Check-In/Check-Out (CICO)

A targeted (or Tier 2) intervention that builds upon a school’s Tier 1 systems by providing some students a higher frequency of scheduled, positive feedback from adults and progress monitoring regarding the school-wide behavior expectations through the use of a daily report card (otherwise known as BEP.)

CICO

see Check-In/Check-Out
Coach

Individual that builds capacity of district and/or school teams through coordination, evaluation, technical assistance and training supports.

Cool Tools

Lesson plans for teaching behavioral expectations

Community Member

Individual who lives within the district’s geographic catchment area. This could include a range of people (ex: business owner, community leader, civil employee, recreation organizer, volunteer, etc.)

Community Representative

A community member, who is NOT an employee of the target district, who actively participates on a school or district PBIS planning team.

Complex/Multiple-life-domain FBA/BIPs

A function-based support plan that addresses needs across life domains (e.g. home, school, and/or community) developed as a result of a Functional Behavior Assessment (FBA.) Designed for youth not responding to Tier 2/Secondary supports and/or for whom a Tier 2 intervention would not be intense enough to reduce the impact of social behaviors on academic participation. Highly individualized interventions, FBA / BIPS are developed based on assessed maintaining function of the problem behavior or skill-deficit (ex: youth needs to know how to appropriately ask for attention.)

Cultural Responsiveness

Using cultural knowledge, prior experiences, frames of reference, and performance styles of ethnically diverse students to make learning encounters more relevant and effective for them (Gay, 2000). Requires that teacher / school personnel have knowledge about students and families.

Disproportionality

“refers to a particular racial/ethnic group being represented in a given category at a significantly higher or lower rate than other racial/ethnic groups” (Equity Project at Indiana University); also “the extent to which membership in a given group affects the probability of being placed in a specific special education disability category” (Oswald, Coutinho, Best & Singh, 1999)

DPR

Daily Progress Report: A tool (often a card or piece of paper) that tracks student progress, utilizing a point system, toward meeting academic and or social expectations throughout the school day.

EBS

Effective Behaviors Support Survey (see SAS)
EE

Education Environment (see LRE)

Expectations

A set (usually 3-5) of positively stated school-wide rules that apply to all staff and students in the building.

External Coach

A district-level individual that facilitates the district team’s process of establishing and maintaining the implementation of positive behavior support systems.

Family Member

Individual involved in the home-life of a child in the district. This could include a range of people (ex: parents/primary care givers, siblings, aunts, grandparents, etc.)

Family Representative

A family member of a child that attends the target school/district, who is NOT an employee of the target district, who actively participates on a school or district PBIS planning team.

FBA

Functional Behavioral Assessment: Systematic process of identifying problem behaviors, and the events that predict and maintain those behaviors. Conducted via a series of interviews and observations and used to develop a Behavior Intervention Plan.

Gotcha

An example of a school name for a tangible acknowledgement (i.e., paper, ticket, post card, etc.) earned by a student “caught” demonstrating positive behavior. Distributed by adult school personnel.

IDEA

Individuals with Disabilities Education Act: A federal law created to protect the rights of students with disabilities who require special education, and their families, by ensuring everyone receives a free appropriate public education.

IEP

Individualized Education Program: A written, legal document that defines the plan/program developed for every child eligible to receive special education services. IEPs are required by law for every student with a disability needing special education services because of that disability. Teachers are legally bound to deliver the accommodations and modifications as written into the IEP.

Interconnected Systems Framework

Integrating the work of the National PBIS Center and the Center for School Mental Health, to include the experiences and knowledge of both, in an effort to build a more responsive and effective connection between mental health and education in
schools, guided by youth and families.

Internal Coach

Building-based individual that facilitates the school-based team’s development, implementation and maintenance of school-wide positive behavior support systems.

ISS

In School Suspensions

LAN

Local Area Network: Voluntary, inclusive and community based bodies with the express purpose of improving the welfare of children and their families. LANs are comprised of the traditional human service systems, families, community members, service professionals and educators working together to meet the needs of at-risk children and their families. (also referred to as a C&A LAN – Child & Adolescent Local Area Network)

LRE

Least Restrictive Environment: IDEA mandates that every student with a disability has the right to be educated in the most ‘least restrictive environment’ possible for that individual student (also known as EE)

MAP

Multi-Tiered Action Plan (see Action Plan)

NCLB

No Child Left Behind Act: Federal legislation, signed into law in January 2002, that requires schools to administer statewide standardized tests annually to all students, report (and meet) their Adequate Yearly Progress (AYP), and provide ‘highly qualified teachers’ to all students.

ODRs

Office Discipline Referrals: Means of tracking and reporting discipline infractions.

OSS

Out of School Suspension

PBIS

Positive Behavior Interventions and Supports: proactive systems approach to establishing the behavioral supports and social culture needed for all students in a school to achieve social, emotional, and academic success.

PBS
Positive Behavior Supports (another name for PBIS)

PoI

Phases of Implementation: The Illinois Phases of Implementation Rubric is the primary tool by which implementation of the PBIS process is measured at all levels.

Reinforcers

Tangible and intangible acknowledgements, or rewards, for positive behavior; make desired behavior more likely.

RENEW

Rehabilitation, Empowerment, Natural supports, Education & Work (Malloy, Drake, Cloutier, Couture), 2011: A unique application of wraparound specifically designed for older, transition-aged youth (16-21) at risk of alternative placement and school dropout. RENEW focuses specifically on increasing effective school engagement, employment, and post-secondary education and completion for older, transition-aged youth, who have experienced the most system failure over time.

Restorative Justice

A philosophy based on a set of principles that guide the response to conflict and harm. The three main goals are 1) accountability: opportunities for wrongdoers to be accountable to those they have harmed; 2) community safety: keeping the community safe by building relationships and empowering community members; and 3) competency development: increasing the pro-social skills of those who have harmed others, addressing underlying factors that lead to the delinquent behaviors, and building upon strengths in each young person. (Implementing Restorative Justice: A guide for schools; ICJIA)

RtI

Response to Intervention: Multi-tiered system of support for redesigning and establishing teaching and learning environments that are effective, efficient, relevant and durable for all students, families, and educators. RtI is also defined as “the practice of providing high-quality instruction and interventions matched to student need, monitoring progress frequently to make decisions about changes in instruction or goals, and applying child response data to important education decisions” (Batsche).

SAIG

Social/Academic Instructional Group: Small instructional groups provided for youth around a common need for direct instruction and practice of either (1) school appropriate social behavior; (2) academic access skill (organization, note taking, asking question, etc.); or (3) both academic and social skills.

SAS: Self-Assessment Survey

Annual assessment for building level staff of school-wide, classroom, non-classroom, and individual behavior practices. This tool assists with annual action planning, internal decision making and assessment of change over time. (Previously known as EBS: Effective Behaviors Support Survey)

SET

School-wide Evaluation Tool: External evaluation tool used to assess a school’s implementation of PBIS by evaluating on-going
SIMEO

Systematic Information Management for Educational Outcomes: Data collection and reporting system that generates graphs and charts for integrated data-based decision-making. These SIMEO tools/reports help monitor progress for students in need of Tier 2 and Tier 3 supports, and guide teams in creating effective plans.

Simple Secondary Interventions

Quick and easy interventions for a group of students within the school demonstrating similar needs not responding to Tier 1/Universal supports: e.g., Check-in/Check-out (CICO) and Social/Academic Instructional Groups (SAIG).

Simple Secondary Interventions with individualized features

A unique feature for an individual student added to a group intervention (e.g. CICO with individualized check in times, check in personnel, or modified individualized goals.)

SRT

System Response Tool: The SRT assists school teams in reflecting on and action planning to improve their school's typical responses to challenging youth behavior.

SSBD

Systematic Screening for Behavior Disorders: Universal Screening Tool that identifies externalizing and internalizing behaviors that may impede academic and social functioning.

SSS

School Safety Survey: This survey assesses risk factors and response plans for school safety and violence. Data provides scores in both risk factors and protective factors.

SWIS: School Wide Information System

Web-based data collection and reporting system for office discipline referrals. (see “Big 5 Data”)

TAC

PBIS Technical Assistance Coordinator: provides training and technical assistance to school/district coaches, administrators, and facilitators in implementing PBIS.

TAD

PBIS Technical Assistance Director: provides statewide and regional leadership, and supports TACs in their training and technical assistance of districts.
TIC

Team Implementation Checklist: designed to be completed by the PBIS team once per quarter to monitor activities for implementation of PBIS in the school, and guide action planning and team activities throughout the year. (action plan is to be completed at the same time)

WIT

Wraparound Integrity Tool: The WIT is designed to assess the team’s perception of the integrity of the wraparound process. The tool was designed to assess the four phases of wraparound: engagement and team participation, initial plan development, plan implementation and refinement, and transition.

Wraparound

Wraparound is a family-centered, strength-based philosophy of care used to guide individualized service planning for students with, or at-risk of, emotional/behavioral disabilities and their families.

Wraparound (Wrap) Plan

A complex and comprehensive plan addressing multiple life domain issues across home, school, and community (e.g. basic needs, MH treatment, behavior/academic interventions, as well as multiple behaviors) that is uniquely individualized to the student, and reflective of youth/family voice and choice.

70

BoQ scoring measurement of overall school-wide implementation. Schools scoring 70% or higher are generally considered implementing PBIS at the Universal/Tier 1 level with fidelity.

80/80

SET scoring measurement of overall school-wide implementation. A score of 80 as the total score and 80 on the teaching expectations component generally indicates fidelity of Universal implementation.
PBIS Data Management using Excel

Greg Dorsey & Candi Hayward

So. Region PBIS
Regional Office of Education #02

rgdorsey@roe02.k12.il.us
chayward@roe02.k12.il.us

March 31, 2000
PBIS Data Management using Excel

This handout will look at the different data that can be pulled from the PBIS template for MS Excel. Topics covered include data entry, graphs, multiple workbooks, formulas, reports, filtering, and others.

The template is customizable so that each individual building and district, with just a little editing, may use it. Codes are created by the user, the number depending on need. They may be simple (I1, I2, ...) or more complex by using whole words and phrases.

**PAGE 1 --- Main Data Entry.**

The main entry sheet is a straightforward data entry sheet. In this example, it is filled with some junk data as an example. Across the top row of the spreadsheet are the various types of data we are tracking, (gender, grade, infractions, etc...) and the data then goes across the rows on down. Excel can handle 65536 rows, so don't worry about running out of space.

The codes used are created solely based on the need of the user. For example, under the Location column in the picture above, the codes L1, L2,
L3 through L15 are used. And as seen by the list in appendix A, these codes represent places such as Lunch Room, Gym, Hallway, and so on. *Also, the tracking is in no way limited to a certain number of codes per topic, other than the fact if too many are used, the legends on the graphs are harder to print in a reader friendly way.*

**Last PAGE --- Data For Graph**

The data for graph page is very important for the graphing. The reason being that when the separate pages are used for each report, the data is broken over many lines and Excel is unable to graph anything but a straight line of data, either across or down (in versions older than Office 2000).

In the picture above, each piece of data that is to be graphed is laid out in a solid line. This data will need to be placed in the report view, shown below. This is done by copying the formulas from the Data for Graph page to the sheet it belongs on, in this case the location sheet.
A Look at Formulas

The formula that all of the data is collected from is virtually the same for each time, with only a minor change for each. The basic formula looks like:

```
=COUNTIF('Main Data'!$column$first row:$column$last row,"Code")
```

For the location formula above the gym (circled in example above fig 1.3) would be:

```
=COUNTIF('Main Data'!$F$4:$F$300,"L1")
```

The formula always counts the number of times a certain item appears in a given range.

<table>
<thead>
<tr>
<th>=</th>
<th>COUNTIF</th>
<th>(&quot;Main Data&quot;!$F$4:$F$300,&quot;L1&quot;)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The equal sign always starts an equation</td>
<td>COUNTIF formula will count the number of times a certain item appears in a given range.</td>
<td>Main Data refers to the main data sheet that the equation is calculating from. This is not needed if the calculation is done on the same worksheet.</td>
</tr>
<tr>
<td>The F and 4 are the column and row identifiers that show where the formula range starts. The dollar ($) states that the equation will always point to these cells.</td>
<td>The Colon is always used as a break between the start and finish of a range.</td>
<td>Same as $F$4 only representing the end of the range. This number can go up to 65536 so there is plenty of room.</td>
</tr>
<tr>
<td>The L1 represents what the formula is counting: in this case L1 represents the occurrences of Infractions that take place in the Gym.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VI - 3, p. 29
In the section above, taken from the location page, the equations are in the format above. Each one is exactly the same except for the code that it is counting. The gym uses the formula 

=COUNTIF('Main Data'!$F$4:$F$300,"L1")

While the classroom uses 

=COUNTIF('Main Data'!$F$4:$F$300,"L2")

The playground would use "L3", the Cafeteria "L4" and so on.

### Setting Up the Formulas in Each Sheet

To set up the formulas for the calculations, go to the Data for Graph sheet. It will be easier to keep track of the formulas if all of the computations are done in one place. Create a list going across with the first list of data that is being charted. Again using the location numbers it would look something like this.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Gym</td>
<td>Classroom</td>
<td>Playground</td>
<td>Cafeteria</td>
<td>Hallway</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>1</td>
</tr>
</tbody>
</table>

Next set up the initial formula, which should be the first item, in this case, Gym. As seen above, the formula for gym would be 

=COUNTIF('Main Data'!$F$4:$F$300,"L1")

After setting up the initial formula, it can be copied to the remaining cells by using the drag command.

1. Place the cursor on the bottom right corner of the cell with formula in it. In this case A4. (Circled above) The cursor will change from the “3-D” plus to a simple plus (+).
2. Click and hold down the mouse button and move the mouse over to highlight the entire row that the formula is to be copied into. (See below).
3. Once the entire row that the formula is going into is highlighted (as shown with the dashed line) release the mouse button.

4. All of the newly filled cells will be the same as the first. In this case the 1 that is under GYM. Move to the next cell under CLASSROOM (Cell B4). In the formula bar, change the L1 to L2 leaving the rest of the formula alone.

5. Do this for each of the cells, changing only the Code (L1, L2,...) in each to correspond with the header in ROW 3 that each code reflects.

6. Repeat this for each Column in the MAIN DATA page that has data to track. (Time, Infraction, Consequence, etc...)

*** Remember that these numbers can always be changed, added or subtracted later.

### Setting up Individual Report Sheets

To create the individual data sheets, choose insert from the top menu bar, and then choose worksheet. This will insert a blank worksheet in the spreadsheet. Rename it by choosing Format → Sheet → Rename. Name it for whichever information that will be reported on in that page, as below.

<table>
<thead>
<tr>
<th>Infraction</th>
<th>Location</th>
<th>Time</th>
<th>Consequence</th>
<th>Grade</th>
<th>Gender</th>
</tr>
</thead>
</table>

Copy the information from the Data for Graph sheet to the new sheet created by highlighting the cells to be copied, choosing copy from the Edit menu, move to the new worksheet by clicking on the sheets name, put the cursor where the cells should be pasted to, and choose Edit → Paste.

### Report Sheets - in Depth

After covering the basics of the formulas, this next session will look at the individual parts of the report sheets, such as the formatting and the graphs, and how to create and manipulate each of those pieces.
When setting up the individual report sheets, the first step is to copy the formulas from the Data for Graph page.

1. Go to the Data for Graph Sheet by clicking on the sheet’s title along the bottom of the page.
2. Click on the first cell of the range to be copied and hold the mouse button down. Move the mouse to the last cell in the range and release the button. In this instance, the range would be the yellow row with the titles and the next row with the formulas.
3. From the top menu bar, choose Edit → Copy.
4. Move back to the report sheet that the data is going into, by clicking on its title on the bottom of the page.
5. Place the cursor in the cell that the data is to be copied into. In the example above, cell A3 is the first cell in the range. Choose Edit → Paste.
6. Using the Cut command, move the cells so that they are on multiple rows if needed, as in the example above, where the 8th grade data starts on a new row.

Next we need to graph the data. This is done using the Chart Wizard (circled above).
7. Click on the **Chart Wizard** button on the menu bar.

8. Choose the type of Graph needed. Column sometimes works best with large amounts of Data, but any of the choices may be made. Click **Next**.

9. Next, enter the data range. To do this, click on the small button at the end of the range box. The screen will go back to the spreadsheet. Click on **Data for Graph**; highlight the range to be graphed in the same method as the copying above. Click on the small button again. This will lead back to the graph wizard.

10. From the **Series In** option, choose whether the graph data is in columns or rows. In this example, choose **Columns**. Click **Next**.

11. Title the Chart if desired, then click **Next**, then **Finish**. The graph will pop up the work sheet. Move the graph to the position desired.

12. Repeat this for each report sheet.

**Tracking Data Monthly & Over Time**

Data of this type can be informative both over a longer period of time like a semester or school year, or shorter amounts of time, like a month. The simplest way to do this is to track all the data on one long running sheet, then at the end of the month, copy that months data to a new sheet. To do this, first create a blank template of the sheet for future uses.

1. **Go to the Main Data** sheet. Highlight all of the data in the sheet, except the column headers and hit the **delete** key.

2. **Go to the top menu bar, and choose File → Save As...**
3. In the **Save as Type** (circled) choose **Template**. Under **Save In**, change to the **Spreadsheet Solutions** folder on the hard drive, usually in Microsoft Office → Templates.

4. Name the file, and hit the **Save** button.

Now that a blank template is created, the monthly sheets can be done.

5. Choose **File → New**. Click on the **Spreadsheet Solutions** tab. Choose the file created in the steps above.

6. Open the main tracking document. Sort by date.
   - Click on the first cell in the header row, in the examples above, cell A3 (Student Name)
   - From the Top Menu Bar, choose **Data → Sort**.
   - In the window that pops up, choose sort by **Date**. Click **Ok**.

7. Go to the first day of entry for the month to be pulled out. For example, if pulling out the December data, move to the row that might contain 12/1/99.

8. Click on the Row Number that has the first entry for the month. Holding down the button, move the mouse down till all of the rows for that month are highlighted.

9. Choose **Edit → Copy**. Switch to the new blank document.

10. Click in the cell where the first line of data is to go, A4 in the example above. Choose **Edit → Paste**

11. Do a **File → Save As...** and name the file, in this case, December. Click **Save**.

Repeat this at the end of each month. That way there will be a running total and a monthly total. This can also be done for any amount of time, or to track any one piece of information, not just dates.
Filtering Data

In some instances, data may be filtered to look at a certain piece of information, such as one particular student’s infractions, the number of a certain infraction, referrals from a particular teacher, the number of infractions that happen in a given location, and so on. Filtering can do this.

To Filter:

1. As in the sorting example above, in the **Main Data** sheet, click on the first cell of the title row (**A3, Student name**).
2. From the top menu bar, choose **Data → Filter → Auto Filter**.
3. This will place little arrows on each of the items. These drop down arrows will give all of the items in that column as choices.
4. Click on the arrow of the topic to filter by, and choose the criteria. In this example, clicking on Jordan would give only the rows that Jordan was the referring teacher. Data can be filtered by more than one category by choosing the first criteria, and then by choosing a second from what that leaves and so on.
5. Once the data has been properly filtered, copy the data to a blank template as in the example above. That information is now graphed in a new sheet. **Filtering in a document does not affect the graphs in that document.** The new information must be copied to a new sheet for the data to be graphed alone.
<table>
<thead>
<tr>
<th>Student Name</th>
<th>Grade</th>
<th>Gender</th>
<th>Ethnicity</th>
<th>Referrer (e.g. teacher, monitor, etc)</th>
<th>Infraction</th>
<th>Location</th>
<th>Date</th>
<th>Time</th>
<th>Consequence</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Kinder</td>
<td>1st Grade</td>
<td>2nd Grade</td>
<td>3rd Grade</td>
<td>4th Grade</td>
<td>5th Grade</td>
<td>6th Grade</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Kinder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7th Grade</td>
<td>8th Grade</td>
<td>9th Grade</td>
<td>10th Grade</td>
<td>11th Grade</td>
<td>12th Grade</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Series1](image-url)
### GENDER

<table>
<thead>
<tr>
<th>Code</th>
<th>Male</th>
<th>Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Male</td>
<td>Female</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Series1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Female</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Series1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Female</td>
</tr>
</tbody>
</table>
### Ethnicity

<table>
<thead>
<tr>
<th>Code</th>
<th>LA</th>
<th>AA</th>
<th>AS</th>
<th>AN</th>
<th>NA</th>
<th>PI</th>
<th>MU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Latino</td>
<td>African Am.</td>
<td>Asian</td>
<td>Anglo</td>
<td>Native Am</td>
<td>Pacific Island</td>
<td>MULTI</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Latino</th>
<th>African Am.</th>
<th>Asian</th>
<th>Anglo</th>
<th>Native Am</th>
<th>Pacific Island</th>
<th>MULTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.1</td>
<td>0.2</td>
<td>0.3</td>
<td>0.4</td>
<td>0.5</td>
<td>0.6</td>
<td>0.7</td>
</tr>
<tr>
<td>0.8</td>
<td>0.9</td>
<td>1.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>R1</td>
<td>R2</td>
<td>R3</td>
<td>R4</td>
<td>R5</td>
<td>R6</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

![Chart](chart.png)
<table>
<thead>
<tr>
<th></th>
<th>R13</th>
<th>R14</th>
<th>R15</th>
<th>R16</th>
<th>R17</th>
<th>R18</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>R19</td>
<td>R20</td>
<td>R21</td>
<td>R22</td>
<td>R23</td>
<td>R24</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>R25</td>
<td>R26</td>
<td>R27</td>
<td>R28</td>
<td>R29</td>
<td>R30</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>R31</td>
<td>R32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>insert name</td>
<td>insert name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### GRADE

<table>
<thead>
<tr>
<th>Code</th>
<th>Kinder</th>
<th>1st Grade</th>
<th>2nd Grade</th>
<th>3rd Grade</th>
<th>4th Grade</th>
<th>5th Grade</th>
<th>6th Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Kinder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![Chart](chart.png)
<table>
<thead>
<tr>
<th>Code</th>
<th>Male</th>
<th>Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Male</td>
<td>Female</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![Graph showing gender distribution](image-url)
<table>
<thead>
<tr>
<th>Code</th>
<th>LA</th>
<th>AA</th>
<th>AS</th>
<th>AN</th>
<th>NA</th>
<th>PI</th>
<th>MU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Latino</td>
<td>African Am.</td>
<td>Asian</td>
<td>Anglo</td>
<td>Native Am</td>
<td>Pacific Island</td>
<td>MULTI</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![Chart](chart.png)
<table>
<thead>
<tr>
<th></th>
<th>I6</th>
<th>I7</th>
<th>I8</th>
<th>I9</th>
<th>I10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>insert infraction</td>
<td>insert infraction</td>
<td>insert infraction</td>
<td>insert infraction</td>
<td>insert infraction</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Series 1**

![Graph](image)
<table>
<thead>
<tr>
<th>Code</th>
<th>R1</th>
<th>R2</th>
<th>R3</th>
<th>R4</th>
<th>R5</th>
<th>R6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
<td>insert name</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![Graph with Series1]
<table>
<thead>
<tr>
<th>Code</th>
<th>BS</th>
<th>AS</th>
<th>LU</th>
<th>P0</th>
<th>P1</th>
<th>P2</th>
<th>P3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Before School</td>
<td>After School</td>
<td>Lunch</td>
<td>insert class</td>
<td>insert class</td>
<td>insert class</td>
<td>insert class</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![chart]

**Series1**
<table>
<thead>
<tr>
<th>Code</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
<th>C5</th>
<th>C6</th>
<th>C7</th>
<th>C8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
<td>Insert</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

![Graph](Image)
What is “Positive Behavioral Support”?  
PBIS focuses on **PROACTIVE** support strategies that  
- reduce the likelihood of problem behavior  
- allow individual students to be as independent and successful as possible in the school setting,  
- encompass a range of strategies from systemic to individual supports  

First...  
A basic understanding of Positive Behavioral Interventions and Supports and How it fits with Problem Solving Model  

**PBIS Continuum**  
- **Universal Interventions** - proactive strategies supporting all students  
- **Targeted Interventions** - specialized strategies supporting students with at risk behaviors  
- **Intensive Interventions** - individualized strategies supporting students with high risk behaviors  

80% of Students
Positive Behavioral Interventions & Supports

Universal
- School-wide PBIS
  - System wide procedures
  - School wide systems
  - Classroom systems
  - Non classroom systems
- Proactive management ideas
  - Informal/formal data collection and evaluation

Targeted
- PSM Team / IAP / IEP
- PSM Interventions
- IAP or IEP
- Functional Behavior Assessment
- Behavior Intervention Plan
- Data collection, assessment, observation
- Mental Health in the Schools

Intensive
- PSM Team / IAP / IEP
- Formal evaluation
- Functional Behavior Assessment
- Behavior Intervention Plan
- Manifestation Determination
- Short-Term Suspension Analysis Worksheet

Problem Solving Continuum

Levels of Intervention
- INTENSIVE 1 – 7%
- STRATEGIC 5 - 15%
- CORE 80 - 90%

School-wide systems to support student achievement.

How Do the Processes Align?
The most important alignment is that both support most students through "universal" school/classroom processes, some students through more "targeted" support, and a small group with the most "intensive" support.

Other Areas of Alignment Include:
- Baseline data collection
- Analysis of data collected
- Design interventions
- Identification of who, what, where teaching will occur
- Implementation of interventions
- Charting/Progress Monitoring
- Analysis of progress
- Continue implementation, change the interventions same, change the interventions significantly
- Continue with the review plan, intervene, analyze process
- Based in Behavior Analysis

Data Collection
Collecting Data in Many Ways to Assist in the Development of Intervention Strategies

Adapted from Sugai and Horner
Why do you need to collect data?

• to implement best teaching practices
• to report progress to parents
• to collect information regarding a student or students’ performance
• to address the I.D.E.A. “Special Factors” requirement for a student with an IEP
• to monitor a behavior or the response to an intervention directed towards the behavior
• to determine eligibility for accommodations or educational services

Ways to Collect Data . . .

Informal

Basic Conduct Chart

<table>
<thead>
<tr>
<th>NAME</th>
<th>DATES TO</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCHEDULE</th>
<th>BEHAVIOR #1</th>
<th>BEHAVIOR #2</th>
<th>BEHAVIOR #3</th>
<th>BONUS POINTS</th>
<th>STEPS/HOME WORK/AGENDA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TEACHER COMMENTS: ____________________________

PARENT COMMENTS: ____________________________

From "Practical Charts for Managing Behaviors" by Lynn Lanvelle

Time Increments Chart

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BEHAVIOR</th>
<th>7:30</th>
<th>8:00</th>
<th>8:30</th>
<th>9:00</th>
<th>9:30</th>
<th>10:00</th>
<th>10:30</th>
<th>11:00</th>
<th>11:30</th>
<th>12:00</th>
<th>12:30</th>
<th>1:00</th>
<th>1:30</th>
<th>2:00</th>
<th>2:30</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Morning Points Afternoon Points

Parent Signature ____________________________

From "Practical Charts for Managing Behaviors" by Lynn Lanvelle
Ways to Collect Data . . .

Formal

Start time: 8:05  End time: 9:00  Setting: Seventh-grade math class
Definition of behavior: Talking out is defined as any noise that is made without first raising hand in appropriate manner and waiting for permission to speak.
Observer: Carol Burke (math teacher)

<table>
<thead>
<tr>
<th>Student</th>
<th>Mon. 3/2/98</th>
<th>Tues. 3/3/98</th>
<th>Wed. 3/4/98</th>
<th>Thurs. 3/5/98</th>
<th>Fri. 3/6/98</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sammy</td>
<td>III</td>
<td>III</td>
<td>III</td>
<td>III</td>
<td>II</td>
</tr>
<tr>
<td>Karen</td>
<td>I</td>
<td>I</td>
<td>II</td>
<td>III</td>
<td>I</td>
</tr>
<tr>
<td>Chris</td>
<td>III</td>
<td>III</td>
<td>III</td>
<td>III</td>
<td>III</td>
</tr>
</tbody>
</table>

Key: Each tick mark represents one talk-out.

Sample Event Record

Ways to Collect Data . . .

Formal

Student: Bugs Bailey
Start time: 8:05  End time: 8:15  Setting: seventh-grade English class
Definition of behavior: On-task behavior is defined as appropriately writing, reading, talking about the assignment, or waiting to ask the teacher a question regarding the assignment.
Observer: Daily Duck (recess monitor)

<table>
<thead>
<tr>
<th>Minute</th>
<th>10s</th>
<th>20s</th>
<th>30s</th>
<th>40s</th>
<th>50s</th>
<th>60s</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>O</td>
<td>N</td>
<td>N</td>
<td>X</td>
<td>N</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Key: O = Behavior was not observed at all during the 10-second interval. X = Behavior was observed at least once during the 10-second interval. 10s = 10 seconds.

Sample Interval Recording

Another Data Collection Tool

Sample Completed Data Collection Tool
Example Format for Data Collection

<table>
<thead>
<tr>
<th>Frequency Data Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student:</td>
</tr>
<tr>
<td>Teacher:</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

NHCS PBIS 3 Tool

And Now What?

Organize and Summarize

- Record behaviors that can be seen and measured
- Collect information across time and settings
- Utilize multiple observers, if possible
- Utilize data collection tools

Be Specific
Be Concise
Be Descriptive
Just the facts!

Analyze the Data

- Are there patterns?
- Are there specific locations, times, subjects or people? (Triggers)
- Are there physical signals of impending problems?
- How often do the behaviors occur? (frequency)
- How long do behaviors last? (duration)
- How severe or damaging are the behaviors? (intensity)
- Can the student continue with their school day when behavioral episode is over?
### NHCS PBIS 4 Tool

#### Example Format for Data Analysis

<table>
<thead>
<tr>
<th>Behavior Off Limits (What student does)</th>
<th>Frequency 1 (How often occur per hour, day, week)</th>
<th>Intensity 2 (How severe or memorable is the behavior, moderate, severe)</th>
<th>Resolution 3 (How long lasts, minutes, hours)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Intervention and Evaluation

- Change aspects of the environment that trigger challenging behavior
- Teach the student more acceptable ways to get their needs met
- Change aspects of the environment that happen following the behavior
- Collect data and evaluate impact of interventions on behavior

---

### Research

#### What We Should Know About Behaviors

- George Batsche
  - Professor of Psychological and Social Foundations
  - Coordinator of Graduate Programs in School Psychology @ USF (University of South Florida)
  - College of Education

Specialty: Bullying, adolescent depression, aggression, violence prevention. Batsche has been on NBC Today, Oprah Winfrey and 20/20 on bullying, aggression and violence prevention.
Focus on Tiers (Levels) I & II as General Education Requirement

Tier I
- Data on Office & Discipline referrals and Actions that took place
- School wide Positive Behavioral Interventions and Supports
- Second Step

Tier II
- Direct behavior training (social skills)
- Additional training or groups (self-instruction, anger control, organizational skills)
- Development of Programs in the school to address top areas of need

Focus of Tier (Level) III as More Formal Process

Team Meets & Typically begins
- Formal Collection of data (Frequency data)
- Completion of Functional Behavioral Assessment (FBA)
- Design of a Behavioral Intervention Plan (BIP)
- Implementation of BIP
- Progress Monitoring

What about Progress Monitoring & Peer Comparisons?

Level of Behavior “necessary for success” versus Level of Current, Local Peer Performance

- On Task
- Compliant
- Accuracy of Work

Level of Behavior Necessary for Success (Proficient Level)
- 75% for On Task
- 90% for Accuracy of Work

Peer could be as high as 90% but this is more than proficient. National Standard (NCLB) is proficient.

But What About the Most Severe Behaviors?

- Harmful to self or others: Assault and battery
- Not Harmful to self or others but causes significant disruption of the learning environment.

Target for replacement behavior would need to be higher than the 75% proficient level

100% would need to be the target level for replacement behavior.
What Are We Doing?

What We Are Doing With Behaviors

What Have We Been Doing?

- Progress monitored by observing student at least 3 times a week
- Remembered that we needed to progress monitor academic areas that were impacted by the behavior
- Charted results of our behavior observations and our academic probes
- Utilized same decision making strategies regarding changing the interventions as we would with an academic only issue
- Remembered that students who have behavioral issues but have no educational impact would continue at PSM intervention level but would not be eligible for consideration for entitlement.

What Criteria Have We Used?

- Student must meet all of the criteria set despite intervention at grade level and a minimum of three changes in the hypotheses and strategies per skill area.
- Criteria can be met using
  - progress monitoring in one academic area and one behavioral area OR
  - in two behavioral areas.

NHCS Behavior Criteria

- Student must meet all of the criteria indicated despite
  - intervention at grade level
  - a minimum of 3 changes in hypotheses & strategies per skill area
- Criteria can be met using progress monitoring in
  - 1 academic area & 1 behavior area OR
  - 2 behavior areas
NHCS Behavior Criteria

4 Criteria Areas

1. Performance well below peers as evidenced by performance below goal(s) set below.
   a) Replacement behavior goal set @ 100% for behavior that
      i. Is or may be harmful to self and/or others. EXAMPLES INCLUDE BUT ARE NOT LIMITED TO
         • Assault (any act of such nature to excite an apprehension of a harmful or offensive physical contact with the person or another) and
         • Battery (intentional and un-permitted physical contact with the person of another).
      ii. Is not harmful to self or others but causes significant disruption of the learning environment as defined by acting in any manner so as to interfere with any teacher’s ability to conduct a class or other school activity. These behaviors may require removal of the student from the classroom in some instances. EXAMPLES INCLUDE BUT ARE NOT LIMITED TO
         • Cursing
         • Tantrums

   b) Replacement behavior goal set @ 75% for behavior that
      i. Involves noncompliance without overt aggressive behaviors generally referred to as
         • Insubordination (the refusal to carry out a reasonable request by a staff member and/or refusal to abide by reasonable school and/or classroom rules). EXAMPLES INCLUDE BUT ARE NOT LIMITED TO
             - Ignoring adult requests or directives to return to seat, start assignment, and redirect to assigned physical space
      ii. Involves lack of work completion
      iii. Involves time off task

2. Rate of Growth below peers
   a) The trend line of the data must be compared to the aimline.
   b) It must be compared based on the percentages used (75% or 100%).
   c) Must determine if the trend line of the data is not projected to intersect with the aimline in 18 weeks or less.
   d) If it is not projected to intersect in the 18 weeks or less then the rate of growth criteria has been met.

3. Intensity and nature of instruction in the last part of Level III must resemble specially designed instruction.

4. Federal & state adverse educational impact is met when each of the three criteria (1-3 in this section) are met.
   a) Performance well below peers
   b) Rate of Growth below peers
   c) Intensity of instruction required in Level III resembles specially designed instruction

Progress Monitoring

Using the Student’s Progress to Monitor Effectiveness of the PSM Intervention Strategies
Progress Monitor Student’s Response to Interventions

- Progress monitor by observing student at least 3 times a week
- Remember you need to progress monitor academic areas that are impacted by the behavior
- Chart results of your behavior observations and your academic probes
- Utilize same decision making strategies regarding changing the interventions as you would with an academic only issue
- Remember that students who have behavioral issues but there is no educational impact will continue at PSM intervention level but will not be eligible for consideration for entitlement.

Example Baseline Data on Tyler Teal

- Student: Tyler Teal
- Grade 3
- Target Behavior: On Task
- Baseline Data:
  - Day 1 26/60 = 43%
  - Day 2 46/60 = 77%
  - Day 3 32/60 = 54%
  - Median 32/60 = 54%

I just know I can do my work.

Set Goal for Tyler Teal

- On task behavior falls under “level of behavior necessary for success” or proficiency level which is 75%
- Goal for Tyler Teal’s on task behavior would be 45/60 (75%).
- Current baseline for Tyler Teal is 32/60 or 54%
Will Tyler Teal get to Proficient Level within 18 weeks of Intervention?

- Consider whether Tyler will likely reach the 75% within 18 weeks or less
- Ask if Tyler’s projected “on task” behavior (trend) line will intersect the “aim line” within the time period above.

If no, then the “Growth Rate” Behavior criteria has been met.
If yes, the “Growth Rate” Behavior criteria has NOT been met.

Another Example:

Situation: Toby has low incidence but high intensity behaviors that meet the definition of “assault”. (i.e. hitting adults & peers such that there are safety concerns)
Toby’s Baseline: 4 thirty minute intervals in a day without incident (4/12) or 33%
Goal: 12/12 intervals without incident or 100%
Note: There are 12 thirty minute intervals in the day. (6 hour day)

Progress Monitoring

- Teacher records intervals without incidents in the 12 thirty minute intervals during each day. Simply use checks on a chart for intervals without incident.
- Record your data on a Progress Monitoring chart.

What about Toby Toms? Would you project that he will reach 100% in 18 weeks or less?
Some Notes

• Be very specific in defining the behavior you plan to target for progress monitoring. Example: What does “on task” behavior look like?
• Don’t make the mistake of observing and collecting data on the negative behavior only.
• Be sure to progress monitor the positive behavior.
• Don’t teach any of the behaviors in your BIP until you get your baseline data.
• When doing progress monitoring use same the time frame for collecting data and stick to straight numbers and not percentages (if possible).

Resources

• NHCS Positive Behavioral Interventions and Supports Training Modules
• NHCS Special Education & Related Services Manual
• “Practical Charts for Managing Behavior” by Lynn Lavelle (Pro-ed Publishing)
• Web Resources
  - www.pbis.org
  - http://cecp.ear.org
  - www.interventioncentral.com
  - www.udel.edu
  - http://darkwing.uoregon.edu/~ttobin/
    (Click on Case Study)
  - http://www.specialconnections.by.edu/cgi-
    bin/sgwp/specconn/main.php?cat=behavior&section=cases
  - http://usfcollab.fmhi.usf.edu/expertdetail.cfm?staffid=4
The Components and Elements of Check & Connect

Check & Connect has four main components and three main elements:

Components of Check & Connect

1. The Mentor: A person assigned to a specific student(s) who builds a strong relationship with him/her based on mutual trust and open communication, nurtured through a long-term commitment focused on success at school and with learning. This person may be called a mentor, monitor, graduation coach, intervention specialist, etc.

2. “Check” Component: Systematic monitoring of student performance variables (warning signs of disengagement such as attendance, grades, and behavior referrals) using data readily available to school personnel.

3. “Connect” Component: Timely, personalized, data-based interventions designed to provide support tailored to individual student needs, based on the student’s level of engagement with school (“check” data), associated influences of home and school, and leveraging of local resources.

4. Parent/Family Engagement: Mentors partner with parents/families. They work with caseloads of students and families for at least two years, functioning as liaisons between home and school and striving to build constructive family-school relationships.

Elements of Check & Connect

1. Relationships: Are based in mutual trust and open communication and nurtured through a long-term commitment focused on promoting a student’s educational success.

   • Focus on alterable variables: Refers to systematic monitoring (i.e., “checking”) of indicators of disengagement (attendance, grades, behavior) that are readily available to school personnel and can be altered through intervention.

   • Personalized, data-based intervention: Refers to “connect” interventions, which are supportive interventions that are personalized, not prescriptive. Mentors use data—including information on the student’s needs (“check” data and student perspective), family circumstances, and availability of school and community resources—as the basis for intervention design. It is expected that different students on a mentor’s caseload will receive different interventions.

   • Long-term commitment: Means that interventions are implemented for a minimum of two years. Mentors make a two-year commitment, which may involve following highly mobile youth and families from school to school and program to program within a district.

   • Participation and affiliation with school: Means that mentors facilitate student access to and active participation in school-related activities and events.

2. Problem Solving and Capacity Building: Means a cognitive-behavioral approach is used to
promote the acquisition of skills to resolve conflict constructively, encourage the search for solutions rather than a source of blame, foster productive coping skills, and diminish dependency on the mentor.

3. **Persistence Plus:** Refers to persistence, continuity, and consistency. The mentor is a persistent source of academic motivation, is familiar with the youth and family (continuity), and conveys the message that “education is important for your future” (consistency).
Active Decision-making: Transforming Data into Useful Information

Rob Horner, Anne Todd, Steve Newton, Bob Algozine, Kate Algozine

www.pbis.org
www.sswi.org
www.pbssurveys.org

Goals

- Logic for school-wide Positive Behavior Support
- Design of “decision-systems” for schools
- Collection and use of data for decision-making
  - Whole school
  - Targeted groups
  - Individual student

Main Messages

- Supporting social behavior is central to achieving academic gains.

- School-wide PBS is an evidence-based practice for building a positive social culture that will promote both social and academic success.

- Implementation of any evidence-based practice requires a more coordinated focus than typically expected.

Logic for School-wide PBS

- Schools face a set of difficult challenges today
  - Multiple expectations
  - Academic, social, emotional, behavioral, safety
  - Students arrive at school with widely differing understandings of what is socially acceptable.
  - Traditional “get tough” and “zero tolerance” approaches are insufficient.

- Individual student interventions
  - Effective, but can’t meet need

- School-wide discipline systems
  - Establish a social culture within which both social and academic success is more likely
What is School-wide Positive Behavior Support?

- **School-wide PBS is:**
  - A systems approach for establishing the social culture and individualized behavioral supports needed for schools to achieve both social and academic success for all students.

- **Evidence-based features of SW-PBS**
  - Prevention
  - Define and teach positive social expectations
  - Acknowledge positive behavior
  - Arrange consistent consequences for problem behavior
  - On-going collection and use of data for decision-making
  - Continuum of intensive, individual interventions.
  - Administrative leadership – Team-based implementation (Systems that support effective practices)

---

Establishing a Social Culture

- **Common Language**
- **MEMBERSHIP**
- **Common Experience**
- **Common Vision/Values**

---

Six Basic Recommendations for Implementing PBIS

- Never stop doing what is already working

- Always look for the smallest change that will produce the largest effect
  - Avoid defining a large number of goals
  - Do a small number of things well

- Do not add something new without also defining what you will stop doing to make the addition possible.
Six Basic Recommendations for Implementing PBIS

- Collect and use data for decision-making
- Adapt any initiative to make it “fit” your school community, culture, context.
  - Families
  - Students
  - Faculty
  - Fiscal-political structure
- Establish policy clarity before investing in implementation

Michigan: Distribution of Elementary Reading Intervention Level

Using Data within PBIS

- Use data to assess current status
  - EBS Self-assessment Survey
- Use data to assess implementation fidelity
  - pbssurveys.org
  - Benchmarks of Quality (BoQ)
- Use data to assess impact on students
  - Office Discipline referrals
Use Data for Decision-making

- “We are all continually faced with a series of great opportunities, brilliantly disguised as insoluble problems.”
  - John Gardner

Main Ideas

- Decisions are more likely to be effective and efficient when they are based on data.
- The quality of decision-making depends most on the first step (defining the problem to be solved)
  - Define problems with precision and clarity

Main Ideas

- Data help us ask the right questions...they do not provide the answers: Use data to
  - Identify problems
  - Refine problems
  - Define the questions that lead to solutions
- Data help place the “problem” in the context rather than in the students.
Decision-making at many levels

- Whole school
- Small groups or school areas
- Individual student
- Same basic process

Using Data

- Use data to identify a possible problem?
- Use data to build a precise “problem statement”?
- Use data to select a solution (intervention)
- Use data to assess if a solution is (a) being implemented, and (b) being effective.

Use data within “decision systems” not “data systems”

<table>
<thead>
<tr>
<th>Question</th>
<th>Decision</th>
<th>Data Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is there a problem?</td>
<td>Should we allocate resources to this problem?</td>
<td>Compare “observed” with “expected” (ODR, ORF)</td>
</tr>
<tr>
<td>Is there a reasonable solution?</td>
<td>Do we have a reasonable intervention, and should it be implemented?</td>
<td>Technical adequacy Contextual Fit</td>
</tr>
<tr>
<td>Is the intervention being implemented as planned?</td>
<td>Do we need more resources to implement the intervention?</td>
<td>On-going data related to fidelity of implementation</td>
</tr>
<tr>
<td>Is the intervention proving effective?</td>
<td>Should we continue the intervention, modify it, or terminate it?</td>
<td>On-going data related to impact of the intervention on student behavior</td>
</tr>
</tbody>
</table>
Using Data

- Use data in “decision layers”
- Don’t drown in the data
- It’s “OK” to be doing well
Six things to avoid

- Define a solution before defining the problem
- Build solutions from broadly defined, or fuzzy problem statements
- Failure to use data to confirm/define problem
- Agree on a solution without building a plan for how to implement or evaluate the solution
- Agree on a solution but never assess if the solution was implemented
- Serial problem solving without decisions

Using Data for Decision-making at the Whole School Level

- Identifying “problems” with “precision”
  - Well defined problems prompt functional solutions
  - Poorly defined problems prompt discussions in which the problem is admired, but not addressed.

- “Well begun is half done”
  - Aristotle, quoting a proverb
Precise Problem Statements
(What are the data we need for a decision?)

- Solvable problem statements include information about the five core “W” questions.
  - **What** is problem, and how often is it happening
  - **Where** is it happening
  - **Who** is engaged in the behavior
  - **When** the problem is most likely
  - **Why** the problem is sustaining

“Everything is vague to a degree you do not realize till you have tried to make it precise.”
- Bertrand Russell

Primary versus Precision Statements

<table>
<thead>
<tr>
<th><strong>Primary Statements</strong></th>
<th><strong>Precision Statements</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Too many referrals</td>
<td>There are more ODRs for aggression on the playground than last year. These are most likely to occur during first recess, with a large number of students, and the aggression is related to getting access to the new playground equipment.</td>
</tr>
<tr>
<td>September has more suspensions than last year</td>
<td></td>
</tr>
<tr>
<td>Gang behavior is increasing</td>
<td></td>
</tr>
<tr>
<td>The cafeteria is out of control</td>
<td></td>
</tr>
<tr>
<td>Student disrespect is out of control</td>
<td></td>
</tr>
</tbody>
</table>

Primary versus Precision Statements

<table>
<thead>
<tr>
<th><strong>Primary Statements</strong></th>
<th><strong>Precision Statements</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Too many referrals</td>
<td>There are more ODRs for aggression on the playground than last year. These are most likely to occur during first recess, with a large number of students, and the aggression is related to getting access to the new playground equipment.</td>
</tr>
<tr>
<td>September has more suspensions than last year</td>
<td></td>
</tr>
<tr>
<td>Gang behavior is increasing</td>
<td></td>
</tr>
<tr>
<td>The cafeteria is out of control</td>
<td></td>
</tr>
<tr>
<td>Student disrespect is out of control</td>
<td></td>
</tr>
</tbody>
</table>
Precise or Primary Statement?

- Children are using inappropriate language with a high frequency in the presence of both adults and other children. This is creating a sense of disrespect and inability in the school setting.
- James D. is hitting others in the cafeteria during lunch, and his hitting is maintained by peer attention.

Precise or Primary Statement?

- ODRs during December are higher than in any other month.
- Minor disrespect and disruption are increasing over time, and are most likely during the last 15 minutes of our block periods when students are engaged in independent seat work. This pattern is most common in 7th and 8th grades, involves many students, and appears to be maintained by escape from work (but may also be maintained by peer attention… we are not sure).

Precise or Primary Statement?

- Three 5th grade boys are name-calling and touching girls inappropriately during recess in an apparent attempt to obtain attention and possibly unsophisticated sexual expression.
- Boys are engaging in sexual harassment.

Organizing Data for Decision-making

- Compare data across time
- Moving from counts to count/month
Using Data

- Identifying a possible problem: A difference between what you want and what you have.
  - What data to review?
    - Office discipline referrals per day per month
    - Avoid simple counts
    - Avoid one data point (look at trends)
  - How to use data
    - Compare with national standards
    - Compare with local standards
    - Compare with prior experience

**Average Referrals Per Day per Month**
Average Office Discipline Referrals per day per month as of January 10

**SWIS summary 07-08 (Majors Only)**
2,532 schools; 1,300,140 students; 1,139,119 ODRs

<table>
<thead>
<tr>
<th>Grade Range</th>
<th>Number of Schools</th>
<th>Mean Enrollment per school</th>
<th>Mean ODRs per 100 per school day</th>
</tr>
</thead>
<tbody>
<tr>
<td>K-6</td>
<td>1762</td>
<td>444</td>
<td>35 (sd=46) (1/300 /day)</td>
</tr>
<tr>
<td>6-9</td>
<td>482</td>
<td>653</td>
<td>92 (sd=1.42) (1/110 /day)</td>
</tr>
<tr>
<td>9-12</td>
<td>176</td>
<td>914</td>
<td>1.06 (sd=.1.57) (1/105 /day)</td>
</tr>
<tr>
<td>K-(K-12)</td>
<td>312</td>
<td>401</td>
<td>1.00 (sd=.1.86) (1/155 /day)</td>
</tr>
</tbody>
</table>
Interpreting Office Referral Data:
Is there a problem?

- **Absolute level** (depending on size of school)
  - Middle, High Schools (> 1 per day per 100)
  - Elementary Schools (>1 per day per 300)

- **Trends**
  - Peaks before breaks?
  - Gradual increasing trend across year?

- **Compare levels to last year**
  - Improvement?

---

**Office Referrals per Day per Month**

**Elementary School with 150 Students**

- **Office Referrals per Day**
  - Sept: 0.5, Oct: 1.0, Nov: 1.5, Dec: 1.0, Jan: 1.0, Feb: 1.5, Mar: 1.0, Apr: 1.5, May: 1.0, Jun: 0.5

**High School of 1800 Students**

- **Office Referrals per Day**
  - Sept: 20, Oct: 15, Nov: 10, Dec: 5, Jan: 10, Feb: 15, Mar: 20, Apr: 15, May: 10, Jun: 5

---

<table>
<thead>
<tr>
<th>Application Activity: Absolute Value</th>
<th>Is there a Problem?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare with national average: 625/100 = 6.25</td>
<td>6.25 X 92 = 575</td>
</tr>
</tbody>
</table>

---

VI - 3, p. 81
Is There a Problem? #2

- Absolute - Trend - Compare

Office Referrals per Day per Month
This year (Middle)

Office Referrals per Day per Month
Last Year and This Year

What are the data you are most likely to need to move from a Primary to a Precise statement?
- What problem behaviors are most common?
  - ODR per Problem Behavior
- Where are problem behaviors most likely?
  - ODR per Location
- When are problem behaviors most likely?
  - ODR per time of day
- Who is engaged in problem behavior?
  - ODR per student
- Why are problem behaviors sustaining?
  - No graph
What other data may you want?

- ODR by staff
- ODR by IEP
- ODR by grade
- ODR by gender by grade

Test precision problem statement

- Use precision problem statement to build and test hypotheses.
  - Problems are most common in D-Hall wing
  - Problems are more likely during second recess
  - Problems are most common during assembly schedule
  - Problems are more likely during state testing periods
What behaviors are problematic?

Referrals per Prob Behavior

Where are the problems occurring?

Referrals by Location

Where are the problems occurring?

Referrals by Location

Who is contributing to the problem?

Referrals per Student
Who is contributing to the problem?

Students per Number of Referrals

When are the problems occurring?

Referrals by Time of Day

When are the problems occurring?

Referrals by Time of Day

Moving to fine-grained analysis

- SWIS Custom Reports
A Context for Designing Solutions

- Behavior support is the redesign of environments, not the redesign of individuals
  - Attend as much, or more, to what happens between problem behavior bouts as what happens during instances of problem behavior.
    - (Edward Carr)

- Positive Behavior Support plans define changes in the behavior of those who will implement the plan.

Building Solutions

- Packages versus Practices
  - Many good ideas, packages and procedures exist
  - Most are expensive to implement, and not a perfect fit with your problem
  - Be efficient as well as effective

- Most good interventions will be multi-component
  - Be wary of the one-trick strategy.
Using Data to Build Solutions:
Four Elements to Consider

- **Prevention:** How can we avoid the problem context?
  - Who, What, Where
  - Schedule change, curriculum change, etc
- **Teaching:** How can we define, teach, and monitor what we want?
  - Teach appropriate behavior
  - Use problem behavior as negative example
- **Recognition:** How can we build in systematic reward for desired behavior?
- **Extinction:** How can we prevent problem behavior from being rewarded?
- **Consequences:** What are efficient, consistent consequences for problem behavior?
- **Monitoring:** How will we collect and use data to evaluate (a) implementation fidelity, and (b) impact on student outcomes?

Solution Development

<table>
<thead>
<tr>
<th>Prevention</th>
<th>Teaching</th>
<th>Reward</th>
<th>Extinction</th>
<th>Corrective Consequence</th>
<th>Data Collection</th>
</tr>
</thead>
</table>

Problem solving Mantra

- **Do we have a problem?**
  - (Identify the primary problem)
- **What is the precise nature of the problem?**
  - (Define, clarify, confirm/disconfirm inference)
- **Why does the problem exist, & what should we do about it?**
  - (Hypothesis & solution)
- **What are the actual elements of our plan?**
  - (Action Plan... what will we do, who will do it, when it gets done)
- **Is our plan being implemented?**
  - (Evaluate & revise plan)
- **Is the plan having the desired effect?**
  - (Maintain, modify or terminate the plan)

- **Quick example of the five step process with East Elementary**
  - 500 students
  - K-5
Rose Elementary Problem Identified

1. For all but one month during last year (2004-2005), the rate of ODRs per day exceeded the national average reported by elementary schools across the United States.

2. The data show a minimal trend across months, but there are noticeable increases in the ODR level in December and March.

3. For each month of the last school year, the level of ODRs per day exceeded the level from the corresponding month during the prior school year (2003-2004).

4. Teachers, families, and students themselves have reported that student problem behavior is unacceptable and presents a barrier to effective instruction.

Step two: develop and clarify hypothesis

Referrals by Student

Referrals by Problem Behavior
Rose Elementary Hypothesis Statement

- A large proportion of students are engaging in disruption & aggression on the playground during recess because
  - We have not developed playground specific expectations and taught them to students
  - Playground supervisors have not been included as participants in the planning, teaching and evaluation
  - Disruption and aggression are resulting in access to peer attention and time with preferred equipment.

Designing Solutions

- If many students are making the same mistake it typically is the system that needs to change not the students.
- Teach, monitor and reward before relying on punishment.
- An example (hallways)
Examples

Trevor Test Middle School

565 students
Grades 6, 7, 8
### Custom Report
**ODRs for This Week from Cafeteria**

| Date       | 1st Name  | 2nd Name | Code | Type | Time(s) | Hours | Days | Date Comment
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1/24/16</td>
<td>Robby</td>
<td>Francisco</td>
<td>5</td>
<td>Call</td>
<td>7:00 AM</td>
<td>1</td>
<td></td>
<td>7/9</td>
</tr>
<tr>
<td>1/24/16</td>
<td>John</td>
<td>Rodriguez</td>
<td>6</td>
<td>Call</td>
<td>11:30 AM</td>
<td>2</td>
<td>7/10</td>
<td></td>
</tr>
<tr>
<td>1/24/16</td>
<td>Larry</td>
<td>Garcia</td>
<td>7</td>
<td>Call</td>
<td>12:00 PM</td>
<td>2</td>
<td>7/11</td>
<td></td>
</tr>
<tr>
<td>1/25/16</td>
<td>Tony</td>
<td>Thompson</td>
<td>8</td>
<td>Call</td>
<td>12:00 PM</td>
<td>3</td>
<td>7/12</td>
<td></td>
</tr>
<tr>
<td>1/25/16</td>
<td>Mary</td>
<td>Smith</td>
<td>9</td>
<td>Call</td>
<td>10:30 AM</td>
<td>5</td>
<td>7/13</td>
<td></td>
</tr>
</tbody>
</table>

### Precision Statement/Hypothesis
- What
- Where
- When
- Who
- Why
- What other info needed?

- Possible Solutions?

### Precise Problem Statement & Hypothesis Development
- Many students from all grade levels are engaging in disruption, inappropriate language and harassment in cafeteria and hallway during lunch, and the behavior is maintained by peer attention.

- A smaller number of students engage in skipping and noncompliance/defiance in classes, (mostly in rooms 13, 14 and 18), and these behaviors appear to be maintained by escape.

### Solution Development

<table>
<thead>
<tr>
<th>Prevention</th>
<th>Teaching</th>
<th>Reward</th>
<th>Extinction</th>
<th>Corrective Consequence</th>
<th>Data Collection</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VI - 3, p. 92
Solution Development: For disruption in hall and cafeteria

<table>
<thead>
<tr>
<th>Prevention</th>
<th>Teach behavioral expectations in cafeteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching</td>
<td>Maintain current lunch schedule, but shift classes to balance numbers.</td>
</tr>
<tr>
<td>Reward</td>
<td>Establish “Friday Five”: Extra 5 min of lunch on Friday for five good days.</td>
</tr>
<tr>
<td>Extinction</td>
<td>Encourage all students to work for “Friday Five”... make reward for problem behavior less likely</td>
</tr>
<tr>
<td>Corrective Consequence</td>
<td>Active supervision, and continued early consequence (ODR)</td>
</tr>
<tr>
<td>Data Collection</td>
<td>Maintain ODR record and supervisor weekly report</td>
</tr>
</tbody>
</table>

Langley Elementary School

478 Students

K-5
Precision Statement/Hypothesis

- What
- Where
- When
- Who
- Why
- What other info needed?
- Possible Solutions?

Solution Development

<table>
<thead>
<tr>
<th>Prevention</th>
<th>Teaching</th>
<th>Reward</th>
<th>Extinction</th>
<th>Corrective Consequence</th>
<th>Data Collection</th>
</tr>
</thead>
</table>

Next Steps

- High School Example
- Your School
- Individual Student Supports
- Planning for implementation

Sandhill High School
354 students
Case 4:74-cv-00090-DCB   Document 1965-1   Filed 09/28/16   Page 153 of 404

Sandhill High School: 354 students

Sandhill High School

Custom Report: Classroom

- Many students in many contexts… primarily disrespect, and skipping.
### Precision Statement/Hypothesis
- What
- Where
- When
- Who
- Why
- What other info needed?

### Grade Level Example
- Mark Twain Elementary
- Elliot Middle
- Gorman High School

### Your School
- Use the Office Discipline Referral Summary
  - Build from your SWIS data, or your best guess from 07-08
- Compute the national average for your school
  - Elementary: 0.35 per 100 per day
  - Middle: 0.92 per 100 per day
  - High: 1.06 per 100 per day
  - K- (8 or 12): 1.00 per 100 per day
  - Enrollment / 100 X (rate for your grade level)

### Your School
- Build your best guess about the patterns for:
  - Location
  - Time of day
  - Type of problem behavior
  - What proportion of students have 0-1; 2-5; 6+ ODRs?
- Do we have a problem?
- Can we define it with precision?
Your School

- Review Data
- Do we have a problem?
- Define problem with precision (or plan party)
- Develop solution options
- Define Action plan needed to implement solution

Solution Development

<table>
<thead>
<tr>
<th>Prevention</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching</td>
<td></td>
</tr>
<tr>
<td>Reward</td>
<td></td>
</tr>
<tr>
<td>Extinction</td>
<td></td>
</tr>
<tr>
<td>Corrective Consequence</td>
<td></td>
</tr>
<tr>
<td>Data Collection</td>
<td></td>
</tr>
</tbody>
</table>

Your School

- Use the solution model to build “possible elements of a solution”
  - Remember that you may have many that are appropriate
  - Identify many, then select the option(s) that are most likely to be both effective and “doable” in your school

- Action Plan
  - Who will do what when?
**User Transcript**

Name: Karen Ward  
Employee ID: 001264  
Sites: Tucson, Office of Prevention Education  
Demographics: Retired; Union: ACR ACR ASRS Working Retirees

<table>
<thead>
<tr>
<th>#</th>
<th>Survey</th>
<th>Course #</th>
<th>Section</th>
<th>Title</th>
<th>Start Date</th>
<th>End Date</th>
<th>Certificate #</th>
<th>Registration Status</th>
<th>Clock Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>11583</td>
<td>14388</td>
<td></td>
<td>USP: Creating Supportive and Inclusive Learning (SAIL) Environments Overview: Refining Our Professional Practice</td>
<td>03/26/2014</td>
<td>03/26/2014</td>
<td>97998700</td>
<td>Completed</td>
<td>3.0 Hours Staff Development</td>
</tr>
<tr>
<td>2.</td>
<td>11210</td>
<td>13819</td>
<td></td>
<td>USP: Grant Tracker Training</td>
<td>08/12/2013</td>
<td>08/12/2013</td>
<td>85301213</td>
<td>Completed</td>
<td>1.5 Hours Staff Development</td>
</tr>
<tr>
<td>3.</td>
<td>11275</td>
<td>13809</td>
<td></td>
<td>Teacher Evaluation Training</td>
<td>08/09/2013</td>
<td>08/17/2013</td>
<td>51031677</td>
<td>Completed</td>
<td>24.0 Hours Staff Development</td>
</tr>
<tr>
<td>4.</td>
<td>11362</td>
<td>13846</td>
<td></td>
<td>Certificated: Teacher Evaluation Training</td>
<td>07/29/2013</td>
<td>07/29/2013</td>
<td>86023981</td>
<td>Completed</td>
<td>3.0 Hours Staff Development</td>
</tr>
<tr>
<td>5.</td>
<td>962</td>
<td>962</td>
<td></td>
<td>2011-12 Mandatory Training: Procurements, Vendor Relations &amp; Public Records</td>
<td><em>Not Set</em></td>
<td>03/20/2012</td>
<td>44336808</td>
<td>Completed</td>
<td>1.0 Hours Staff Development</td>
</tr>
<tr>
<td>6.</td>
<td>934</td>
<td>2010</td>
<td></td>
<td>Learning Supports Coordinator: Learning Focused Conversations</td>
<td>09/29/2011</td>
<td>09/29/2011</td>
<td>2717140</td>
<td>Completed</td>
<td>7.0 Hours Staff Development</td>
</tr>
<tr>
<td>7.</td>
<td>794</td>
<td>1713</td>
<td></td>
<td>Instructional CORE: Essential Elements of Instruction (EEI) - Day 1 &amp; 2</td>
<td>08/08/2011</td>
<td>08/09/2011</td>
<td>20352938</td>
<td>--</td>
<td>12.0 Hours Staff Development</td>
</tr>
<tr>
<td>8.</td>
<td>705</td>
<td>1346</td>
<td></td>
<td>Introduction to Restorative Practices for Elementary Teachers</td>
<td>04/16/2011</td>
<td>04/16/2011</td>
<td>87812971</td>
<td>--</td>
<td>7.0 Hours Staff Development</td>
</tr>
</tbody>
</table>

Total: 39.5 Hours Staff Development